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Lesson Plan

A student with basic or better computer skills learns how to create a budget using Microsoft Excel 2007.

Lesson Objectives
The student will understand and can accomplish these tasks at the end of the lesson:
· Enter text and numbers into an Excel worksheet
· Use Autofill 
· Format cells to display text and numbers effectively
· Perform basic calculations
· Use AutoSum 
· Print a workbook 

Lesson Prep Work
(30 min, at a minimum, prior to student arrival)
· get in early to test for technology failure, because it will happen :-)
· print handouts

Lesson Prerequisites
· Computer Basics series (or equivalent skills)
· All Microsoft Word classes plus practice implementing those skills

Lesson Outline
The lesson is completed in one (120) minute class session.
(5) Introduction
· Introduce instructor, students.
· Ask students at introduction: who has used Excel before? What have you used it to do?
· Let students know it’s okay to take phone calls, but ask them to put their phone on vibrate and answer calls outside the classroom.
· Inform students that they can sit back and watch if the class is too advanced.
· Inform students they can go to the bathroom, they don’t need permission.
· Show order in which class will happen. Explain scope of class.


(5) Introduce Excel
· What is Excel?
· Excel is a powerful spreadsheet software that allows users to 
· Organize data.
· Easily perform complex mathematical equations.
· Link information together.
· Create charts of data.
· Significantly more!
· The Basic Interface
· The Ribbon
· Tabs
· Home – Where your most frequently accessed features live.
· Insert – Adds content beyond basic text to the page (e.g. graphs and pivot tables)
· Page Layout – changes how the page prints (e.g. margins).
· Formulas – The reason Excel is so useful. Tools to have Excel do work for you.
· Data – Organize and summarize data in a workbook.
· Review – Think spell check.
· View – changes how the page looks digitally (e.g. gridlines).
· You can tell which tab is selected because it is highlighted.
· Teacher’s Tip: If students don’t see the same menu options as the instructor, they can always check the tab the instructor has selected to find the right menu.
· Groupings
· Within each tab, there are groupings of like buttons.
· These are used to help you find buttons easier. 
· If I tell you to click the Autosum button, you have to read through every button on the Home tab, but if I tell you to click the Autosum button in the Editing grouping, you can find it right away.
· The Spreadsheet
· Rows – go horizontally across the page. Denoted by a number at the beginning of the row.
· Columns – go vertically across the page. Denoted by a letter at the top of the column.
· Cells – the intersection between a row and a column.
· Cell Address – the column letter and row number of a particular cell.
· Formula Bar – allows you to double check information. The importance of this will become more apparent later.
· Worksheets versus Workbooks
· The tabs at the bottom of the screen allow you to move between worksheets.
· A workbook is made up of one or more worksheets. It is the actual file.
· Basic Navigation
· Click in a cell
· When you open a workbook, you will automatically start with cell A1 selected.
· You can tell which cell is selected because it is surrounded by a thick black box.
· You can move to any cell in your workbook by clicking on it.
· You can tell the cell address of that cell because the column letter and row number will be highlighted.
· Enter: move one row down.
· Tab: move one column to the right.

(5) Add Text
· Explanation
· We are going to build a budget to learn some of the tools Excel offers.
· Teacher’s Tip: It may be worthwhile to demo the finished product for students in the class. Show them the setup of the spreadsheet and how as you change values in various cells, it updates the totals in others.
· To start with, we need to create the content that belongs in our budget.
· Activity: Add basic text to the workbook.
· Step 1 – Click in cell A1.
· Step 2 – Type in Personal Budget.
· Ask students: “what keyboard key can we hit to move down on the page?”
· Step 3 – Press Enter to move down to cell A4.
· Step 4 – Type in the following text in the corresponding cells.
· Teacher’s Tip: Feel free to substitute any of these suggestions.
· Income – A4
· Wages – A5
· Interest – A6
· Misc – A7
· Income Total – A8
· Expenses – A10
· Home – A11
· Mortgage/Rent – A12
· Utilities – A13
· Phone – A14
· Home Improvement/Repairs – A15
· Home Total – A16
· Living – A18
· Groceries – A19
· Child Care – A20
· Eating Out – A21
· Living Total – A22
· Transportation – A24
· Gas – A25
· Insurance – A26
· Parking – A27
· Public Transportation – A28
· Transportation Total – A29
· Expenses Total – A31
· Over/Short – A32
· Assign Homework for Students: Students should practice at home by adding more content to their workbook. They may choose to expand Child Care into its own section or make a new section for Pets…

(5) Formatting Part 1: Cell Size
· Explanation
· The text in several cells crosses over from one column to another.
· If you add text to the next column, it covers up some of the text.
· Click next to Home Improvement… and type in 200.
· Point out that you can’t see the whole text anymore.
· We need to make column A big enough to accommodate all of our text.
· Activity: Make column A wide enough to accommodate text.
· Step 1 – Put your cursor on the line separating columns A and B in the column headings.
· Teacher’s Tip: Point out that the cursor changes to a thick black line with an arrow pointing in either direction.
· Step 2 – Click and drag to the right to make the column wider.
· In this workbook, it is easy to see all of our content, so we know exactly how wide we need to make our column.
· In a workbook 5000 rows long, we would have to scroll for a long time to see make sure everything fit in the first column.
· Step 3 – Undo making the column wider.
· Step 4 – Double click on the line separating columns A and B.
· Teacher’s Tip: There will always be at least one student who tries to grab the line too low on the page. Make sure everyone understands that changing column width happens in the column headings all the way at the top of the page

(5) AutoFill
· Explanation
· Excel has a ton of tools available to make work faster and easier.
· Excel has been programmed to understand cycles, like after January comes February. 
· This means we don’t need to type in all that information on our own.
· Activity: Autofill in Months.
· Step 1 – Type “Jan” in cell B3.
· Step 2 – Confirm the value by pressing Enter.
· Inform students that Excel doesn’t actually see any value until we have confirmed that we are done typing.
· We can confirm values by pressing Enter.
· Step 3 – Go back to cell B3.
· Step 4 – Click and drag the AutoFill handle in the lower right corner of the selected cell until you seen the prompt for December.
· Teacher’s Tip – Draw on the whiteboard the different cursors students will come across. 
· Fat white cross = selection cursor
· Thin black cross = AutoFill
· Thin black cross with arrows = movement (rearrange cells)
· Thick black line with arrow in either direction = cell resize
· Students will get the AutoFill cursor and the Movement cursor confused.

(15) Basic Math
· Explanation
· The true power of Excel isn’t in its ability to organize data, it’s in its ability to do work for you.
· We can have Excel perform basic mathematical functions for us.
· For the sake of ease, everyone is going to make $2000/month salary.
· Activity: Prepare the document.
· Step 1 – Type 2000 into cell B5.
· Ask students: “Is there something we’ve already learned today that might help us put this 2000 in for every month in this budget?”
· Step 2 – AutoFill the 2000 across to December (row M).
· Teacher’s Tip: if you have an engaged bunch of students, show them AutoFill Options. Change the autofill from Copy Cells to Fill Series. Ask students: What’s the difference between these two options? What do you think the other options do?
· Step 3 – Type 0 in cell B6.
· Step 4 – AutoFill the 0 across to M6.
· Step 5 – Type 0 into cell B7.
· Step 6 – AutoFill the 0 across to M7.
· Activity: Perform the basic math for income.
· Explanation: start with =.
· Write on the board: “2000 + 0 + 0 = x” and “x = 2000 + 0 + 0”.
· Ask students: “Do these two things say the same thing?”
· Explain that Excel only understands this equation if it is written “= 1 + 2”.
· Write on the board: ALWAYS START WITH =!
· Explanation: cell references.
· We don’t really want to add the values 2000, 0, and 0. 
· What we want to add is whatever value happens to be in cell B5 to whatever value happens to be in cell B6 to whatever value happens to be in cell B7.
· Instead of referencing actual values in our formula, we are going to reference the cells those values are in. 
· Write on the board “= B5+B6+B7”.
· Now we can add whatever value happens to be in each of those cells instead of precise values.
· Step 1 – Click in cell B8.
· Step 2 – Type in =.
· Step 3 – Click on cell B5.
· Explain that instead of typing in the number 2000, we tell Excel to where to find the number.
· This way, if that number changes, Excel will automatically update the value in cell B8.
· Teacher’s Tip: Tell students that they should CLICK on the cells they are referencing for this class. After class, they are welcome to type in cell references instead. But, on of the most common mistakes I see in classes is people typing in the wrong cell address. Additionally, clicking in the cell reaffirms in the mind what we are actually adding.
· Step 4 – Type in +.
· Step 5 – Click on cell B6.
· Step 6 – Type in +.
· Step 7 – Click on cell B7.
· Point out that all the cells referenced in the formula are highlighted.
· Step 8 – confirm the value by pressing Enter.
· Teacher’s Tip: to make sure students understand why we used a formula, type in 50 in the interest field for January and press Enter. Point out that the total in cell B8 automatically updated.
· Teacher’s Tip: point out that you can’t see the formula anymore, even when you select the cell again. If you click on the cell, you can see the formula in the formula bar.
· Step 9 – AutoFill the formula across row 8 until column M.
· Teacher’s Tip: students will want to know if we just filled 2000 all the way across. Click on another cell in row 8 and ask students to check the formula bar to determine which cells are being referenced. This has to do with cell references being relative by default. If students want to know more about that, encourage them to attend the Formulas and Functions class.

(10) Formatting Part 2: Number Formats
· Explanation
· Right now, even though we are looking at a budget, it isn’t obvious we are talking about money.
· Ask students: “what usually shows that we are talking about money?”
· Dollar signs and decimal points!
· Activity: Change the Cell Formatting to Currency.
· Step 1 – Select the range of cells from B5 to M8.
· Teacher’s Tip: Reinforce that the correct cursor to select is the fat white cross.
· Step 2 – Click on the Number Formatting dropdown menu on the Home Tab in the Number Grouping.
· Step 3 – Select Currency from the list.
· Comprehension Check: Fill in Home Expenses, AutoFill across the screen, use a formula to determine the totals and format as currency.
· Come up with values for the fields as a group. If you struggle, use:
· Mortgage/Rent: 750
· Utilities: 100
· Phone: 80
· Home Improvement/Repairs: 100

(15) AutoSum
· Explanation
· The math we’ve looked at already is great if you only have a few numbers, but what if you were asked to add up a range of 500 numbers?
· Excel understands basic commands like: add all numbers in a range of cells.
· Activity: Fill in Values for Living Expenses and AutoSum the total.
· Come up with the values to put into your budget as a group. If you struggle, use these:
· Groceries: 150
· Child Care: 200
· Eating Out: 60
· Step 1 – Click in cell B22.
· Step 2 – Click on the AutoSum button in the Editing grouping on the Home tab.
· Point out that Excel automatically tries to figure out the range of cells you would like to add.
· Inform students that you can always click and drag to select a different range of cells.
· Step 3 – Press Enter to confirm the value.
· Step 4 – Select the range of cells from B19 – B22 and AutoFill across to column M.
· Step 5 – Set the number formatting to currency.
· Comprehension Check: Independent Practice: Students fill in values for Transportation, AutoSum or basic math the total, AutoFill across, change the formatting to currency.
· Instructor walks around the room to help students who get stuck.
· Make sure to remind students to think about which cursor they are using.
(10) Break!
(10) Math in Unconnected Cells
· Explanation
· So far, we’ve only looked at putting together formulas in contiguous cells.
· Now we look at math performed across the workbook.
· Activity: Create the Expenses Total formula.
· Ask students: “what numbers in this worksheet do you think add up to give us our total expenses?”
· Step 1 – Click in cell B31.
· Step 2 – Type in =.
· Step 3 – Click on cell B16.
· Step 4 – Type in +.
· Step 5 – Click on cell B22.
· Step 6 – Type in +.
· Step 7 – Click on cell B29.
· Step 8 – Press Enter.
· Step 9 – AutoFill across row 31.
· Comprehension Check: Large Group Work: Create a Formula for Over/Short.
· Ask students: “what numbers in this workbook would tell us if we were over or short for our monthly expenses?”
· Make sure students end up with the formula =B8-B31 in cell B32.
· AutoFill the formula across.

(10) Formatting Part 3: Cell Appearance
· Explanation
· Once you have your data, it really helps to use a few tools to make it look better.
· Activity: Make Personal Budget Stand Out on the Page.
· Step 1 – Select cells A1 – M1.
· Step 2 – Change the font to Arial Black.
· Step 3 – Change the font size to 28.
· Step 4 – Change the cell color to dark green.
· Step 5 – Change the font color to white.
· Comprehension Check: Change Income so it stands out on the page  
· Step 1 – Select cells A4 – M4. 
· Step 2 – Change the font to Arial Black.
· Step 3 – Change the font size to 24.
· Step 4 – Change the cell color to a slightly lighter shade of green.
· Step 5 – Change the font color to white.
· Activity: Use the Format Painter.
· Explain: We want to make the same changes to Expenses that we did to Income. We can perform the exact same clicks as we did before, but we should let the computer to the work for us.
· Keep cells A4 – M4 selected.
· Step 1 – Click on the Format Painter in Clipboard grouping on the Home tab.
· Step 2 – Click on cell A10.

(10) Printing
· Explanation
· Many worksheets are going to be too big to fit on one sheet of paper. If you need to print out a worksheet, you need to decide what you want to print and in what order.
· Activity: Perform a Print Preview.
· Step 1 – Click on the Office Button.
· Step 2 – Hover on Print.
· Step 3 – Click on Print Preview.
· Point out that the worksheet doesn’t all fit on one page. 
· Ask students: “what do you think we could do to get it on one page?”
· Activity: Open Print Titles and Change Print Setup.
· Step 1 – Go to the Page Layout tab.
· Step 2 – Click on Print Titles in the Page Setup grouping.
· Sheet tab
· Page Order allow you to determine in what order it makes sense for your worksheet to print. This is particularly useful for long worksheets.
· Header/Footer tab
· Include page numbers for longer worksheets.
· Custom Header/Footer buttons allow you to put in personal touches, like initials.
· Margins tab
· Adjusts the white space on the outside of a document.
· Set this document’s margins to 0.5” all the way around.
· Page tab
· Step 1 - Change Orientation to Landscape.
· Step 2 - Click on Print Preview.
· Step 3 - Go back to the Print Titles dialog box.
· Step 4 - Select Fit to 1 page by 1 page.
· Fit to allows you to make a document fit on one page.
· Ask students: “how would this option look if this was 4000 rows long?”
· If the spreadsheet is big enough, it should NOT be fit to one page.
· Step 5 - Click on Print Preview.

(10) Homework
· Explanation/Discussion 
· Students are expected to practice at least 2 hours between classes. 
· Find help at gcflearnfree.org. 
· Step 1 – Go to gcflearnfree.org.
· Step 2 – Click on the Microsoft Office tile.
· Step 3 – Click on Excel 2013.
· Step 4 – Assign the tutorials on Getting Started with Excel; Creating and Opening Workbooks; Cell Basics; Modifying Columns, Rows, and Cells; Formatting Cells, Worksheet Basics; Printing Workbooks; and Simple Formulas.
· Encourage students to really look over basic mathematical formulas if they don’t know where else to start.

(5) Conclusion 
· Go over handout, review material, and emphasize contact info on handout.
· Any questions? Final comments?
· Remind to take survey.
Appendix
This is what your spreadsheet should look like at the end of class.
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M Personal Budge
= k
3 Jan Feb  Mar  Apr  May  Jun Jul Aug  Sep Ot Nov  Dec
4
5 |Wages $2,200.00 $2,000.00 $2,000.00 $2,000.00 $2,000.00 $2,000.00 $2,000.00 $2,000.00 $2,000.00 $2,000.00 $2,000.00 $2,000.00
6 |Interest $0.00 $0.00 $0.00 $0.00 $0.00 $0.00 $0.00 $0.00 $0.00 $0.00 $0.00 $0.00
7 |Misc. $200.00 $0.00 $0.00 $0.00 $0.00 $0.00 $0.00  $200.00 $0.00 $0.00 $0.00 $0.00
S Income Totals $2,400.00 $2,000.00 $2,000.00 $2,000.00 $2,000.00 $2,000.00 $2,000.00 $2,200.00 $2,000.00 $2,000.00 $2,000.00 $2,000.00
o
Jexpenses |
11 Home
12 Mortgage/Rent $800.00 $800.00 $800.00 $500.00 $800.00 $800.00 $800.00 $B00.00 $800.00 $800.00 $800.00  $800.00
13 |Utilities $125.00 $0.00 $0.00 $0.00 $0.00 $0.00 $0.00 $0.00 $0.00 $0.00 $0.00 $0.00
14 |Phone $75.00  $75.00 $75.00 $75.00 $75.00 $75.00 $75.00 $75.00 $75.00 $75.00 $75.00  $75.00
15 Home Improvement/Repairs  $0.00  $0.00  $0.00  $0.00  $0.00  $0.00  $0.00  $0.00  $0.00  $0.00  $0.00  $0.00
16 Home Totals. $1,000.00 $875.00 $875.00 $875.00 $875.00 $875.00 $875.00 $875.00 $875.00 $875.00 $875.00 $875.00
7
18 Living
19 |Groceries $0.00 $0.00 $0.00 $0.00 $0.00 $0.00 $0.00 $0.00 $0.00 $0.00 $0.00 $0.00
20 |Child Care $0.00 $0.00 $0.00 $0.00 $0.00 $0.00 $0.00 $0.00 $0.00 $0.00 $0.00 $0.00
21 |E: out $0.00 $0.00 $0.00 $0.00 $0.00 $0.00 $0.00 $0.00 $0.00 $0.00 $0.00 $0.00
2 Totals $0.00  $0.00  $0.00  $0.00  $0.00  $0.00  $0.00  $0.00  $0.00  $0.00  $0.00  $0.00
E)
24 Transportation
25 |Gas. $0.00 $0.00 $0.00 $0.00 $0.00 $0.00 $0.00 $0.00 $0.00 $0.00 $0.00 $0.00
26 |Insurance $0.00 $0.00 $0.00 $0.00 $0.00 $0.00 $0.00 $0.00 $0.00 $0.00 $0.00 $0.00
27 |parking $000  $0.00 000 $0.00 $0.00  $0.00  $0.00  $0.00  $0.00  $0.00  $0.00  $0.00
28 |publicTransportation $000  $0.00 000 $0.00  $0.00  $0.00  $0.00  $0.00  $0.00  $0.00  $0.00  $0.00
29 Transportation Totals $000 $000  $0.00 000  $0.00 $0.00  $0.00  $0.00  $0.00  $0.00  $0.00  $0.00
0
31 Expenses Totals $1,000.00 $875.00 $875.00 $875.00 $875.00 $675.00 $875.00 $875.00 $875.00 $875.00 $875.00 $875.00
32 Over/short $1,400.00 $1,125.00 $1,125.00 $1,125.00 $1,125.00 $1,125.00 $1,125.00 $1,325.00 $1,125.00 $1,125.00 $1,125.00 $1,125.00
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